
Project22.qxp  29/11/2007  8:56 PM  Page 1



2

Project22.qxp  29/11/2007  8:56 PM  Page 2



Table of Contents 

Introduction.........................................................................................................................4
An Overview......................................................................................................................5
Tools.......................................................................................................................................6
Using  the options bar.................................................................................................7
Hidden Tools....................................................................................................................8
Create and use  tool presets .....................................................................................8
Tool Preset picker .........................................................................................................8

Image Editing...................................................................................................................10
Eye Manipulation......................................................................................................11
Planet Sakuta................................................................................................................14

Index.......................................................................................................................................21

3

Project22.qxp  29/11/2007  8:56 PM  Page 3



Introduction
Your Tools

You create and manipulate your documents and files using various
elements such as panels, bars, and windows. Any arrangement of
these elements is called a workspace. When you first start an
Adobe Creative Suite component, you see the default workspace,
which you can customize for the tasks you perform there. For
instance, you can create one workspace for editing and another for
viewing, save them, and switch between them as you work.
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Software Needed
Adobe Photoshop CS2 or CS3
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Introduction Your Tools

An Overview
Although default workspaces vary across Flash, Illustrator, InCopy,
InDesign, and Photoshop, you manipulate the elements much the
same way in all of them. The Photoshop default workspace is typi-
cal:

1.The menu bar across the top organizes commands under menus.

2.The Tools panel (called the Tools palette in Photoshop) contains
tools for creating and editing images, artwork, page elements, and
so on. Related tools are grouped together.

3.The Control panel (called the options bar in Photoshop) displays
options for the currently selected tool. (Flash has no Control
panel.)

4.The Document window (called the Stage in Flash) displays the file
you’re working on.

5.Panels (called palettes in Photoshop) help you monitor and mod-
ify your work. Examples include the Timeline in Flash and the
Layers palette in Photoshop. Certain panels are displayed by
default, but you can add any panel by selecting it from the Window
menu. Many panels have menus with panel-specific options.
Panels can be grouped, stacked, or docked.
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Introduction Your Tools

Your Tools
When you start Photoshop, the Tools palette appears at the left of
the screen. Some tools in the Tools palette have options that
appear in the context-sensitive options bar. These include the
tools that let you use type, select, paint, draw, sample, edit, move,
annotate, and view images. Other tools allow you to change fore-
ground/background colors, go to Adobe Online, and work in dif-
ferent modes.

You can expand some tools to show hidden tools beneath them. A
small triangle at the lower right of the tool icon signals the pres-
ence of hidden tools.

You can view information about any tool by positioning the pointer
over it. The name of the tool appears in a tool tip below the point-
er. Some tool tips contain links leading to additional information
about the tool.

View picture on left for a list of tools available to you.

Using  the options bar 
The options bar appears below the menu bar at the top of the
workspace. The options bar is context sensitive—it changes as you
select different tools. Some settings in the options bar (such as
painting modes and opacity) are common to several tools, and
some are specific to one tool. 

You can move the options bar in the workspace by using the grip-
per bar, and you can dock it at the top or bottom of the screen.
Tool tips appear when you position the pointer over a tool. To
show or hide the options bar, choose Window > Options. 
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Chapter 4 Image Editing

Hidden Tools
You can select a preference that allows you to cycle through a set
of hidden tools by holding down the Shift key. When this prefer-
ence is not selected, you can cycle through a set of hidden tools
by pressing the tool’s shortcut key (without holding down Shift).

1.Choose Edit > Preferences > General (Windows) or Photoshop >
2.Preferences > General (Mac OS). 
3.Select Use Shift Key For Tool Switch. 

Create and use  tool presets 
Tool presets let you save and reuse tool settings. You can load,
edit, and create libraries of tool presets using the Tool Preset
picker in the options bar, the Tool Presets palette, and the Preset
Manager. 

To choose a tool preset, click the Tool Preset picker in the options
bar, and select a preset from the pop-up palette. You can also
choose Window > Tool Presets and select a preset in the Tools
Presets palette.

Viewing the Tool Preset picker
Click the Tool Preset picker in the options bar to show the Tool 
Preset pop-up palette.

Select a preset to change the tool’s options to the preset, which
applies each time you select the tool until you choose Reset Tool
from the palette menu.

Deselect to show all tool presets; select to show presets for only
the tool selected in the toolbox.
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Chapter 2
Image Editing

Adobe Photoshop Cs2/3 is a powerful tool, that allows you to
design practically anything. Its only drawback is, it cannot read
your mind and design what your thinking of doing. The subse-
quent pages, I'm going to explain how to manipulate a photo in an
interesting way, and how to design your own planet. 
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Software Needed
Adobe Photoshop CS2 or CS3
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Chapter 2Image Editing

Eye Manipulation
The first image I will be explaining how to design is the eye you
saw on the previous page which is relatively simple to replicate. 

The first step, is to get an image of an eye either from a royalty
free stock image site or grab your camera and take a picture of
your eye. However be warned, make sure the flash is turned off or
you’ll be blinded. 

Once you got your image insert it into Photoshop at whatever res-
olution you like. The first thing you will do is to desaturate the
image.  

(shift + ctrl + U) for Mac (Apple + ctrl + U). 

The next step is to decide what you want your eye to look like.
Should it become an eye of a beast, a robot, a bird, an alien?
Whatever you decide will reflect what images you will use in the
next step. I decided to have a dried, decayed eye. 

Now, its time to find a bunch of images to add to your eye. For
this part I usually go to a royalty free image site like
http://www.imageafter.comor use some of my personal images
that I have taken over the years.

The first thing I do, is find an image that will be the skin of the
eye. Considering, I'm creating a decay looking eye; a rusty piece of
metal is generally perfect for this. Once you found your image, add
it on top of eye, on its own layer. Now, change thelayer blending
modeto discover some interesting effects. However, trial and error
using various images is the best technique at this stage. 

The layer blending modeselector is found right above your layers
in the layer panel. 
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Chapter 2 Image Editing

Eye Manipulation
Another useful tool to use while manipulated images like an eye is
to add a maskto the layer. To do that, simple click on the button
that looks like an circle within a rectangle at the bottom of the
layers panel. 

Review the image on the previous page and this page to see where
the mask layer buttonis found, and how it looks like, once acti-
vated.

The great thing about the mask tool, is that anything you do on
the mask layer isn't permanent. So, if you dislike the changes you
have made, you can simply delete the mask and bang, back to the
original version. 

When on the mask, grab the brush toolfrom the tools panel and
change the foreground colour to white. Now brush over the image
and you noticed it erases the image. To reverse this, simply
change the foreground colour to black. 

Next part of this endeavour is to find another image to compli-
ment what you have done so far. I decided to go with an image
that contained plenty of stones. 

Once I added the image to its own layer, I changed the layer
blending modeto colour burn, and place it bellow the first image.
The blending mode for the first image was changed to multiply.  
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Chapter 2 Image Editing

Eye Manipulation 
The next step I took, was to erase part of the rock image, using
the mask technique I explained earlier. Once I was satisfied, I
decided to add some shadows, mid tones using the burn tool
found in the tools palette. 

Well, that's it, however that doesn't mean you should stop here.
Fool around, try all the wonderful features of Photoshop. That is
the best way to learn! 

Final image is found on the right.
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Chapter 2 Image Editing

Designing the Sakuta Planet

First off, there are many different ways on how to design a planet
from scratch in Photoshop. I will only show you one way but do
not hesitate to explore the various features in Photoshop to devel-
op your own techniques. 

The first step in designing your planet is to make a texturefor the
surface of the planet. You can make it as detailed as you like. 

Create a new canvas in Photoshop at3000 by 3000pixels. The
texture of the planet should be twice as large as the actual planet
will be. 

At this stage, you will need to decide what kind of planet you like
to create. I usually get a picture of rocks, or gravel as the base of
my planets texture. 

Once you've chosen what image to use as your texture base, take
out the clone toolfound in the tools panel. 

Now destroy the image you got with the clone tool, layer blending
mode, or any other effect you see fit.  Once you are satisfied with
the result turn it into a pattern. 

Go to Edit -> Define Texture. Give it a name. 
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Chapter 2 Image Editing

Designing the Sakuta Planet
If you like, close down the canvas that you used to create your
planet texture. Now, create a new canvas and make it 1500 by
1500.

Fill the background of the canvas to black, and create a new layer
and call it base. Now make a perfect circular selection with the
elliptical tool.

Hold (Shift + Ctrl)for Mac  (Shift + Alt) 

Fill the selection with a solid colour. It gives the planet a colour; so
choosing a colour like blue or green will make the planet look live-
ly while a dark orange or red would make the planet look dead.

Don't use bright colours for the base layer. 

Now create a new layer, and call it Land.Ctrl select the base layer
to get a selection. 

Fill the selection with the pattern you created before. Simply select
the Paint Bucket tool and change from fill selection to pattern
selection in the options panel. 

Change the transparency of the Land layer to around 90%. You can
change the transparency in the layers panel at the top. Now, dupli-
cated the layer and change the transparency to around 70%. Now
add a colour to the duplicated layer by opening the hue/saturation
menu.

Press (Alt + U)for Mac (Apple + U)

Before Iforget, you need to add theSpherize effectto the Land
layer, and all layers that proceeed it except the shadows layer.

Filter-> Distort-> Spherize(50%)Then (100%)
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Chapter 2 Image Editing

Designing the Sakuta Planet
Select the duplicated Land layerand add a mask layerto it. Give it
a gradient blend fadewith the gradient tool found as a sub tool
once you hold down the mouse button on the Paint Bucket toolin
the Tools panel. 

Or press(Shift + G)until the gradient toolis selected

Make sure the foreground colour is black, and the background
colour is white. Now use the gradient tool on the mask layer and
fade the image from the direction you want the sunlight to hit. 

Next create a clouds layer and like before, ctrl selectthe base layer
to get the selection you made. Now add the clouds filter effectto
the clouds layer. For this part I usually have the foreground colour
the same as the base colour, and the background colour to white.
Though, exploring different colour combinations will lead to the
best, and most interesting result.

Filter-> Render -> Clouds
(Ctrl + F)To reapply effect if needed

Once you found the right colour for your clouds, and have apply
the Clouds filter; its time to change thelayer blending mode to
give the clouds a more transparent cloud look to it. For this part,
you can change the transparency of the layer if you like. 

After that, duplicate the clouds layertwiceand each time give
them a different layer blending mode effect and rotate the clouds
90 degrees. 

Edit-> Transform -> Rotate 90° CW
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Chapter 2 Image Editing

Designing the Sakuta Planet
Next, you will create an atmosphere layerand give it the same
selection as before but this time expand the selection by 5 pixels. 

Select -> Modify-> Expand

Expanding the selection will help give the illusion that the atmos-
phere is above the planet surface and not right against it. Fill the
selection with your desirable colour. For this I gave it a gradient
colour from light blue to black. 

Move the atmosphere layerbellow the third clouds layer. I found
this gives the planet an interesting effect.  

Finally, its time to add a shadowto your planet to represent the
effect of light hitting your planet from a local star or stars.  

Create a new layer and call it shadow. With the same selection as
before; fill the selection with the colour black. Now give it a
Gaussian blur of about 40 pixels.

Filter-> Blur->Gaussian blur

Once your satisfied with how the shadow looks, it's time to reposi-
tion the location of the shadow depending on where a light source
is going to hit the planet. Thus, having two local stars, one on
either of side of the planet will force the shadow to be in the cen-
ter of the planet, and at a smaller size than the actual planet. 

To Transform the Shadow (Ctrl + T) for Mac (Option + T)

Your almost done, the last thing to do is to add an Outer Glow
effectto the Base layer. To find the Outer Glow effect select the
Add a layer effectbutton at the bottom of the Layers Panel. The
button is in a shape of the initials fx. Give the Base layer a light
bluish Outer Glow, or another colour of your choice. Change the
settings found in the Outer Glow effect panel until you get your
desired effect. 
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Chapter 2 Image Editing
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Chapter 2 Image Editing

Designing the Sakuta Planet

That's it, your done! Though you have your planet now, its time to
explore and add it to background scenery of your choice. I won't
show you how to make a complete space scene but trial and error
along with studying how artists design their space scenes will go a
long way! 

Final image on the right 
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Chapter 2 Image Editing
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Life Times Work
Believe in the unbelievable

http://www.lifetimeswork.ca

Project22.qxp  29/11/2007  8:58 PM  Page 21


